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This guide was created by the staff of the GIS/Data Center at Rice University and is to be used 

for individual educational purposes only.  The exercises outlined in this guide require access to 

particular software and datasets which are available at Fondren Library.  
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Obtaining the Tutorial Data 

Before beginning the tutorial, you will copy all of the required tutorial data onto your Desktop. 

Follow the applicable set of instructions below depending on the particular computer you are 

using. 

Accessing tutorial data from Fondren Library using the gistrain profile 

If you are completing this tutorial from a public computer in Fondren Library and are logged on 

using the gistrain profile, follow the instructions below: 

1. On the Desktop, double-click the Computer icon  gisdata (\\fon-gis04) (O:)  
Short_Courses  Bringing_Data_Into_ArcGIS_Series   Mapping_Tabular_Data. 

2. To create a personal copy of the tutorial data, drag the TabularTutorialData folder 
onto the Desktop. 

3. Close all windows. 

Accessing tutorial data online using a personal computer 

If you are completing this tutorial from a personal computer, you will need to download the 

tutorial data online by following the instructions below: 

1. Using a web browser, go to the Introduction to Coordinate Systems and 
Projections short course webpage at: http://library.rice.edu/gis-tabular 

2. At the bottom of the webpage, under the Resources section, click the Mapping 
Tabular Data – Tutorial Data link to download the tutorial data. 

3. Unzip the TabularTutorialData folder. 

4. Copy the unzipped TabularTutorialData folder to your Desktop or another location 
of your choice. Ensure that you note the file path of the location you have 
selected. 

Any time throughout the tutorial that you see reference to the file path 

C:\Users\gistrain\Desktop\ProjectionsTutorialData, you will need to substitute it with the file 

path you have just selected. 

The following step-by-step instructions and screenshots are based on the Windows 7 operating 

system with the Windows Classic desktop theme and ArcGIS for Desktop 10.1 software with an 

Advanced license. If your personal system configuration varies, you may experience minor 

differences from the instructions and screenshots. 

http://library.rice.edu/gis-tabular
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Joining Tabular Data in ArcMap 

Setting Up a Map Document 

You will begin by opening ArcMap and creating a new map document. 

1. On the desktop, double-click the ArcMap 10.1 icon. 

2. In the ‘ArcMap – Getting Started’ window, ensure that My Templates and the Blank 
Map template are selected. 

At the bottom of the window, notice the default geodatabase for this map is currently set to 

C:\Users\gistrain\Documents\ArcGIS\Default.gdb. The default geodatabase should be set to the 

geodatabase that will contain most of the data for the particular map document you are working 

on. In this case, you will want to use the geodatabase in your TabularTutorialData folder. 

3. Next to the ‘Default geodatabase for this map:’ box, click the Browse button. 

 

4. In the ‘Default Geodatabase’ window, click the Connect To Folder button. 

 

5. In the ‘Connect To Folder’ window, select the TabularTutorialData folder located 
on the Desktop. 

Ensure that the TabularTutorialData folder is highlighted in blue and not the TabularData.gdb 

geodatabase that appears inside it. You never want to connect directly to a geodatabase, as doing 

so will prevent you from being able to access any of the data contained inside of it. 

6. For ‘Folder:’, verify that either the TabularTutorialData folder or the 
C:\Users\gistrain\Desktop\TabularTutorialData filepath is listed and click OK. 

7. In the ‘Default Geodatabase’ window, select the TabularData.gdb geodatabase and 
click Add. 

8. Ensure the ‘Default geodatabase for this map:’ box says 
“C:\Users\gistrain\Desktop\TabularTutorialData \TabularData.gdb” and click OK. 

At this point, it is a good idea to save your map document and to continue saving regularly. 

9. On the Standard toolbar, click the Save button. 
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10. In the ‘Save As’ window, use the ‘Save in:’ drop-down box to select the 
TabularTutorialData folder. 

You will save the map document here, directly inside the TabularTutorialData folder, but NOT 

within the TabularData geodatabase. 

11. For ‘File name:’, type “DowntownParcels” and click Save. 

Remember that, in order for your GIS project to open properly on other computers, you must tell 

the map document to store relative pathnames to its data sources and take your entire project 

folder containing all of your data and your map document with you. 

12. Click the File menu and select Map Document Properties…. 

13. Towards the bottom of the ‘Map Document Properties’ window, click the checkbox 
to ‘Store relative pathnames to data sources’ and click OK. 

14. On the Standard toolbar, click the Save button again to store this setting in your 
map document. 

Adding Tabular Data 

You will now add a feature class to your map document that depicts all of the land parcels in 

downtown Houston. This feature class was obtained from the Harris County Appraisal District 

(HCAD) Public Data GIS website at http://pdata.hcad.org/GIS/index.html. The original parcels 

shapefile contained all of the parcels in Harris County, but working with such a large file can be 

time consuming, so for the purposes of this exercise, the layer was clipped to contain only those 

parcels in downtown Houston. 

1. On the right side of the ArcMap window, click the Catalog tab. 

2. On the Catalog toolbar, click the Go To Default Geodatabase button, which will 
take you to the default geodatabase you specified earlier. 

 

3. Double-click the TabularData geodatabase to expand its contents. 

4. Drag the DowntownParcels feature class into the Map Display. 

You will now examine the DowntownParcels layer’s attribute table. 

5. In the Table of Contents, right-click the DowntownParcels layer and select Open 
Attribute Table. 

6. Scroll to the right and browse through all of the attributes. 

Notice that in the HCAD_NUM field, you are provided with the unique HCAD account number 

for each parcel. You are also provided with the owner name and address for each parcel, but not 

very much other information. Fortunately, a tremendous amount of other information about the 

http://pdata.hcad.org/GIS/index.html
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parcels can be obtained from HCAD in stand-alone tabular format. In this case, you would like to 

know the particular land use for each parcel, for example residential, commercial, or industrial. 

This information is contained in a separate table, which you will now explore. 

7. Close the attribute table. 

8. On the right side of the ArcMap window, click the Catalog tab. 

9. In the TabularData geodatabase, drag the Land table into the Map Display. 

Notice at the top of the Table of Contents, the highlighted icon has switched from the first ‘List 

By Drawing Order’ button to the second ‘List by Source’ button. That switch is because the 

tabular data you just added does not have a graphic component, so it cannot yet be drawn and 

will not appear in the drawing order view. 

10. In the Table of Contents, right-click the Land table and select Open. 

11. Scroll to the right and browse through all of the attributes. 

Notice that you are again provided with the unique HCAD account number, but this time the 

field is labeled ACCOUNT, rather than HCAD_NUM, as it was in the DowntownParcels feature 

class attribute table. You are also provided with the land use code and the land use description 

for each parcel. In order to symbolize the parcels by land use, you will first need to join the land 

use table to the parcels feature class. 

You will now explore the various land use codes. 

12. Right-click the LAND_USE_C field and select Sort Ascending. 

13. Scroll down and browse through all of the land use codes and descriptions. 

Notice how many different land use categories there are. For example, commercial land use is 

divided into very specific categories, such as Restaurant, Ice House, Bar/Lounge, Department 

Store, Medical Office, and Bank. While it is great to have this information available, 

symbolizing so many different categories on a single map can make the map difficult to 

understand. Instead, you would prefer to symbolize the parcels using more generalized land use 

categories. 

Fortunately, the City of Houston has created a lookup table that assigns each appraisal district 

land use code to one of ten generalized land use categories. You will now explore this lookup 

table. 

14. On the right side of the ArcMap window, click the Catalog tab. 

15. In the TabularData geodatabase, drag the LandUseCode_LookupTable table into 
the Map Display. 

16. In the Table of Contents, right-click the LandUseCode_LookupTable table and 
select Open. 
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17. Scroll to the right and browse through all of the attributes. 

Notice that the COUNTY field tells you which county uses the particular land use code listed.  

“HCAD” is for Harris County. If you scroll down, you will notice “FBCAD” and “MCAD” for 

Fort Bend County and Montgomery County, respectively. The LANDUSE_CODE and 

LANDUSE_DESCRIPTION fields should look familiar, since they contain the same information 

as the Land table you looked at previously. The GROUP_CODE and GROUP_DSCR fields store 

one of ten general land use categories that correspond to each specific land use code. In order to 

symbolize the parcels using these generalized land use categories, you will also need to join the 

lookup table to the land use table and the parcels feature class. You will perform the join using 

the land use code field that is common to both your land use table and your lookup table. 

18. Close the attribute tables. 

Joining Tabular Data 

Now that you have examined all of the data tables, you are ready to join them all together. It is 

possible to join tables together in any order, but you want to add both land use tables to the back 

of the attribute table for your parcels layer. To avoid confusion, it is best to perform joins from 

the List by Drawing Order view, so that you don’t accidentally try to join the parcels layer 

attribute table to the back of one of the other tables. 

1. At the top of the Table of Contents, click the List by Drawing Order button. 

 

You will now join the Land table to the DowntownParcels feature class using the unique HCAD 

account number as the common field. 

2. In the Table of Contents, right-click the DowntownParcels layer and select Joins 
and Relates > Join…. 

3. For ‘What do you want to join to this layer?’, ensure that Join attributes from a 
table is selected. 

4. For ‘1. Choose the field in this layer that the join will be based on:’, select the 
HCAD_NUM field. 

5. For ‘2. Choose the table to join to this layer, or load the table from disk:’, select 
the Land table. 

6. For ‘3. Choose the field in the table to base the join on:’, select the ACCOUNT 
field. 

7. Ensure that the ‘Join Data’ window matches that shown below and click OK. 
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8. If asked if you would like to create an index for the join, click Yes. 

9. Right-click the DowntownParcels layer and select Open Attribute Table. 

10. Scroll to the right and browse through all of the attributes. 

Notice the four new fields added to the end of the DowntownParcels attribute table showing the 

land use for every parcel. Because you want to symbolize the parcels using the generalized land 

use categories, you will now also join the LandUseCode_LookupTable table using the land use 

code as the common field. 

11. Close the attribute table. 

12. In the Table of Contents, right-click the DowntownParcels layer and select Joins 
and Relates > Join…. 

13. For ‘What do you want to join to this layer?’, ensure that Join attributes from a 
table is selected. 

14. For ‘1. Choose the field in this layer that the join will be based on:’, select the 
LAND_USE_C field. 

15. For ‘2. Choose the table to join to this layer, or load the table from disk:’, select 
the LandUseCode_LookupTable table. 

For ‘3. Choose the field in the table to base the join on:’, notice that the LANDUSE_CODE field 

that you want to base the join on cannot be selected. This is an indicator that the two join fields 

are probably not of the same type and cannot be joined as is. 

16. Close the ‘Join Data’ window, without completing the join. 

Troubleshooting Joins 

You will now examine the two tables more closely to determine why the desired join field did 

not show up in the’ Join Data’ window. 

1. At the top of the Table of Contents, click the List by Source button to gain access 
to your tables. 
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2. Right-click the Land table and select Open. 

3. Right-click the LandUseCode_LookupTable table and select Open. 

Notice at the bottom left of the ‘Table’ window, you see one tab for each of the two tables that 

are open, but you want to be able to examine both tables simultaneously. 

 

4. At the top of the ‘Table’ window, click the Table Options button and select Arrange 
Tables > New Horizontal Tab Group. 

 

When looking at a table, any column that is left-aligned is treated as text and any column that is 

right-aligned is treated as a number. Examine the two fields that you were previously attempting 

to join. Notice that the LAND_USE_C field in the Land table is right-aligned as a number and the 

LANDUSE_CODE field in the LandUseCode_LookupTable table is left-aligned as a text. For 

further confirmation of this problem, you will examine the properties of each field. 

5. In the Land table, right-click the LAND_USE_C field and select Properties…. 
Notice that the field type is “Long”, which stands for long integer. 

6. Close the ‘Field Properties’ window. 

7. In the LandUseCode_LookupTable table, right-click the LANDUSE_CODE field and 
select Properties…. Notice that the field type is “String”, which is another term for 
text. 

8. Close the ‘Field Properties’ window. 

In order to perform a join, the corresponding join fields in the respective tables must be of the 

same field type. Unlike in Excel, you cannot simply convert an existing field from one type to 

another. Instead, you must create a new field of the correct field type and copy the data over into 

the new field. In this case, you will convert the LAND_USE_C field in the Land table to a string 

field type to match the string field type used in the LandUseCode_LookupTable table. 

9. In the ‘Table’ window, click the Land table to ensure that it is selected. 

10. Click the Table Options button and select Add Field…. 

11. For ‘Name:’, type “LAND_USE_C_Text”. 

12. For ‘Type:’, select Text and click OK. 
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The new LAND_USE_C_Text field has now been added to the end of the Land table. 

13. Right-click the LAND_USE_C_Text field and select Field Calculator…. 

14. When asked if you would like to continue editing outside of an edit session, click 
Yes. 

15. In the Field Calculator window, double-click the LAND_USE_C field. 

Notice that the box at the bottom of the ‘Field Calculator’ window now reads 

LAND_USE_C_Text = [LAND_USE_C], as shown below. This statement will copy all of the 

content from the original LAND_USE_C integer field to the new LAND_USE_C_Text text field. 

 

16. Click OK. 

Ensure that the land use codes have indeed been copied over into the new LAND_USE_C_Text 

field and that they are left-aligned as text. 

17. Close the attribute tables. 

18. At the top of the Table of Contents, click the List by Drawing Order button again. 

You will now attempt to join the tables again using the edited fields, but you will also need to 

redo even your original join, since the Land table has been modified. 

19. In the Table of Contents, right-click the DowntownParcels layer and select Joins 
and Relates > Remove Join(s) > Remove All Joins. 

You will now repeat the process of joining both tables. 

20. In the Table of Contents, right-click the DowntownParcels layer and select Joins 
and Relates > Join…. 

21. For ‘What do you want to join to this layer?’, ensure that Join attributes from a 
table is selected. 

22. For ‘1. Choose the field in this layer that the join will be based on:’, select the 
HCAD_NUM field. 

23. For ‘2. Choose the table to join to this layer, or load the table from disk:’, select 
the Land table. 

24. For ‘3. Choose the field in the table to base the join on:’, select the ACCOUNT 
field. 

25. Ensure that the ‘Join Data’ window matches that shown below and click OK. 
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26. Right-click the DowntownParcels layer and select Open Attribute Table. 

27. Scroll to the right and ensure that the four land use code fields were added. 

28. Close the attribute table. 

29. In the Table of Contents, right-click the DowntownParcels layer and select Joins 
and Relates > Join…. 

30. For ‘What do you want to join to this layer?’, ensure that Join attributes from a 
table is selected. 

31. For ‘1. Choose the field in this layer that the join will be based on:’, select the new 
LAND_USE_C_Text field. 

32. For ‘2. Choose the table to join to this layer, or load the table from disk:’, select 
the LandUseCode_LookupTable table. 

33. For ‘3. Choose the field in the table to base the join on:’, select the 
LANDUSE_CODE field. 

34. Ensure that the ‘Join Data’ window matches that shown below and click OK. 

 

35. If asked if you would like to create an index for the join, click Yes. 

36. Right-click the DowntownParcels layer and select Open Attribute Table. 
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37. Scroll to the right and browse through all of the attributes. 

Notice that the generalized group code and description fields have been added to the end of the 

attribute table. 

38. Close the attribute table. 

39. On the Standard toolbar, click Save. 

Exporting Tabular Data 

The joins that you have created are only stored in this particular map document. In other words, 

none of the original tables have been modified. If you were to add the DowntownParcels layer to 

another new map document, you would no longer see the joined tables at the back of the layer’s 

attribute table. In addition, if your joined data tables were ever moved or deleted, the joined data 

would no longer be visible in this map document. For this reason, it is often a good idea to export 

data containing successful tabular joins, so that you do not have to worry about losing the joined 

data in the future. 

1. Right-click the DowntownParcels layer and select Data > Export Data…. 

Notice that the output feature class defaults to your default geodatabase 

(C:\Users\gistrain\Desktop\TabularTutorialData\TabularData.gdb). 

2. For ‘Output feature class:’, scroll to the end and rename the feature class from 
“Export_Output” to “DowntownParcels_WithLandUse” and click OK. 

 

3. Click Yes to add the exported data to your map as a layer. 

4. Right-click the DowntownParcels_WithLandUse layer and select Open Attribute 
Table. 

Notice that all of the joined attributes are now a permanent part of this new feature class attribute 

table. Since this permanent feature class contains everything you need in one layer, you may now 

remove your original parcels layer and both joined tables. 

5. Close the attribute table. 

6. At the top of the Table of Contents, click the List by Source button to gain access 
to your tables. 

7. Right-click the DowntownParcels layer and select Remove. 

8. Right-click the Land table and select Remove. 

9. Right-click the LandUseCode_LookupTable table and select Remove. 
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10. On the Standard toolbar, click Save. 

You have successfully joined tabular data in ArcMap! 

Mapping Tabular Data 

You will now symbolize the parcels according to their generalized land use categories. 

1. Double-click the DowntownParcels_WithLandUse layer to open the ‘Layer 
Properties’ window and edit the symbology. 

2. Click the Symbology tab. 

3. In the ‘Show:’ box on the left, click Categories and leave the default selection of 
Unique values. 

4. In the ‘Value Field’ drop-down box, select the GROUP_DSCR field. 

5. In the bottom left corner, click Add All Values. 

6. At the top of the list of values, uncheck <all other values>, since there are none in 
this case. 

You will want to group “Commercial” and “Office” into one land use category. 

7. Click the Commercial value to select it. 

8. Hold down Ctrl and click the Office value to select it too. 

9. Right-click the Commercial value and select Group Values to combine the two 
categories into one. 

10. Double-click on each of the symbol patches to change the colors to those 
commonly used by planners to indicate the various land uses, as displayed below. 

 

11. Click OK. 

12. On the Standard toolbar, click Save and minimize ArcMap.  
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Formatting Tabular Data in Excel for Joining 

In the first exercise using HCAD data, both the layer attribute table and the join table were 

already formatted properly, so that you could bring them directly into ArcGIS. Unfortunately, 

such a situation rarely occurs and most data tables require some formatting to prepare them for 

import into ArcGIS. 

In this exercise, you will be mapping land cover by state. The original data table was obtained 

from The 2011 Statistical Abstract published by the U.S. Census Bureau at 

http://www.census.gov/compendia/statab/. The particular table was accessed from the 

“Geography & Environment” section under the “Land, Land Use, and Earthquakes” category and 

was called table “265, Land Cover/Use by State: 2003”.  You will now format this table for 

import into ArcGIS. 

1. Double-click the TabularTutorialData folder on the desktop. 

2. Double-click LandCoverByState to open the file with Excel. 

Along the left side of the spreadsheet are the row numbers. Along the top of the spreadsheet are 

the column letters. When you are asked to click on a row or column, you will be clicking directly 

on these numbers and letters. 

Removing Extraneous Data from Excel Worksheets 

Notice that the first three rows contain title information for the table, but do not contain any data, 

so you will delete these rows. Notice also that row 1 is barely visible, because its height has been 

greatly reduced. 

1. Click and hold row 3 and drag the mouse up past the top of the spreadsheet to 
select rows 1 through 3. 

2. Right-click row 3 and select Delete. 

Sometimes data tables contain a lot more information than you actually need. While it is okay to 

import large tables into ArcMap, it can make future tasks more difficult for you. Every time you 

have to select a particular field for symbology, labels, or queries, you will have to scroll through 

a long list of fields, rather than a targeted list containing only your selected variables of interest. 

For this reason, it is ideal to remove all unnecessary data columns in Excel before importing into 

ArcGIS. 

For this particular exercise, you will map the percent of all land that is developed land and the 

percent of all nonfederal land that is forest land. Such a task will require keeping the columns 

titled “State,” “Total surface area,” “Forest land,” “Developed Land,” and “Water Areas.” You 

will remove all of the rest of the columns. 

3. Click column C to highlight the entire column. 

4. Hold down Ctrl and click columns D, E, F, H, I, L, M, N, O, P. 

http://www.census.gov/compendia/statab/
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Ensure that you are left with the five necessary columns previously mentioned. 

5. Right-click column P and select Delete. 

The selected columns should disappear and you should be left with the columns labeled “State,” 

“Total surface area,” “Forest land,” “Developed Land,” and “Water Areas.” 

When you bring an Excel table into ArcGIS, it assumes that the first row contains the field name 

and then it assumes the data begins in the second row. Whatever data type it sees in that second 

row, it assumes is the data type for the entire column. If there is ever more than one row 

containing title information, ArcGIS will see that title text in the entire second row and assume 

that all the data contained in the entire table is text, when, in fact, the majority of the data is 

numerical. In short, all but one field name row must be removed, but, first, you must create an 

appropriate field name row. 

6. Right-click row 4 and select Insert. 

This newly inserted row will contain your field names. For field names, you should not use any 

spaces or special characters and should not start with a numeral or use more than 13 characters. 

You may use underscores, mixed case letters, and numerals (in the middle or end of the field 

name only). 

7. In row 4, type the following field names: “State” “Total” “Forest” “Developed” 
“Water”. After typing each word, press Delete (rather than Enter or the right 
arrow), so that the unwanted remainder of each phrase is not copied from the row 
above. Ensure that there is not an extra space after the word “State”. 

Since you have created a row with appropriate field names, you may now delete all rows above 

it. 

8. Click row 1. 

9. Hold down Shift and click row 3. 

10. Right-click row 3 and select Delete. 

Because you are mapping data for each state, you do not need the total data for the entire United 

States contained in row 2 or the accidental repeat of the Alabama data in row 3. 

11. Click row 2. 

12. Hold down Shift and click row 3. 

13. Right-click row 3 and select Delete. 

Scroll to the bottom of the table and notice there are extra rows that do not contain data here, as 

well. 

14. Click row 50 (FOOTNOTE:). 
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15. Hold down Shift and click row 56 (Internet release date:). 

16. Right-click row 56 and select Delete. 

Using Formulas in Excel 

At this point, the table is mostly cleaned up, so you will add two new columns to calculate the 

percent of the total land area that is developed and forest. 

1. In cell F1, type “Per_Forest”. 

2. In cell G1, type “Per_Developed”. 

Now you will calculate the formula where Per_Forest = Forest/(Total-Water). 

3. In cell F2, type “=” to indicate the start of a formula. 

4. Click cell C2 (Alabama Forest). 

5. Type “/(” (divided by, open parenthesis). 

6. Click cell B2 (Alabama Total). 

7. Type “-” (minus sign). 

8. Click cell E2 (Alabama Water). 

9. Type “)*100” (close parenthesis, times 100). 

10. Ensure your cell says “=C2/(B2-E2)*100” and press Enter to finish the formula. 

11. Click cell F2 containing the formula you just entered. 

Hover your cursor over the small black box in the bottom right corner of the highlighted cell as 

shown below. Notice that your cursor changes from a thick white cross to a thin black cross. 

12. Double-click the black box in the bottom right of cell F2 to copy the formula down 
the table. 

 

13. In cell G2, use the same formula building techniques to enter “=D2/(B2-E2)*100” 
and copy the formula down the table. 

One last problem with this worksheet, which is difficult to detect, is that there is actually a space 

stored after every state name. This space will prevent the table from joining properly to another 

table whose state names do not have a trailing space. You will now perform a series of 

automated operations to remove this extra space. 
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14. Click column B. 

15. Hold down Shift and click column D. 

16. Right-click column D and select Insert to add three new columns in which to work. 

First, you will use the Text to Columns tool, which splits the information contained in one 

column into multiple columns based on a delimiter. The delimiter is the character which is used 

to signal when to shift the data to the next column. As a result, the delimiter itself is removed and 

all characters following the delimiter are shifted to the next column. In this case you will use the 

space as the delimiter to remove it. 

17. Click column A. 

18. Click the Data tab at the top of the Excel window. 

19. Under the Data Tools section, click the Text to Columns button. 

20. In the ‘Convert Text to Columns Wizard’, click Next >. 

21. In the Delimiters box, uncheck Tab and check Space and click Next >. 

22. Click Finish. 

23. When asked if you want to replace the contents of the destination cells, click OK. 

The extra spaces have been removed, but the state names with two words have been separated 

into two columns. You will need to concatenate them back together into a single column 

separated by a space, but only for those states with two words. Performing a concatenation on all 

the states with an added space in between the two words would end up adding the trailing space 

again. The formula below basically says, if column B is blank, then copy the state name from 

column A; otherwise, if column B contains text, then concatenate the first part of the state name 

in column A with the second part of the state name in column B and add a space in between 

them. 

24. In cell C2, use your formula building techniques to enter 
“=IF(B2="",A2,CONCATENATE(A2," ",B2))”. Ensure that there is no space between 
the first set of quotation marks and a single space between the second set of 
quotation marks. 

In this instance you can’t double-click the black box in the bottom right of cell C2 to copy the 

formula down, because there is not consistent data in the column the left of it. 

25. Click and hold the black box in the bottom right of cell C2 and drag down to cell 
C49 to copy the formula down the table. 

At this point it looks good, but the values contained in column C are actually formulas, not text, 

and ArcGIS will not be able to interpret the formulas. 

26. Right-click column C and select Copy. 
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27. Right-click column D and select Paste Special…. 

28. In the ‘Paste Special’ window, select to Paste Values and click OK. 

Now the states listed in column D are stored as text, rather than as formulas, so you can now 

delete columns A through C. 

29. Click column A. 

30. Hold down Shift and click column C. 

31. Right-click column C and select Delete. 

32. In cell A1, type “State”. 

Removing all formatting in Excel 

At this point your table has everything you need and nothing extra, but it is always recommended 

to clear all formatting and programming, including special fonts, background colors, borders, 

formulas, etc., before bringing the Excel file into ArcGIS.  To get rid of all formatting and 

programming, you will copy all of the data into a new blank worksheet. 

1. Click the Select All button in the top left corner of the spreadsheet. 

 

2. In the Home tab, click Copy. 

 

3. Click the File tab and select New. 

4. Ensure that Blank Workbook is selected and click Create. 

5. In the new workbook, right-click cell A1 and select Paste Special…. 

6. Select to paste Values and click OK. 
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You should now have a clean version of your data with no special formatting. The last step is to 

expand the cells to ensure that all of their content is displayed. 

7. Click column A. 

8. Hold down Shift and click column G. 

Hover your cursor over one of the lines between any two of the column letters. Notice that your 

cursor changes from a single arrow pointing down to a double arrow pointing left and right. 

9. Double-click the dividing line between column A and B. 

The width of all your columns should now be expanded to show all of the cells’ content. You are 

finished formatting your table. 

10. Click the File tab and select Save As. 

11. Navigate to the TabularTutorialData folder on the desktop. 

12. For ‘File name:’, type “US_LandCover”. 

13. For ‘Save as type:’, use the drop-down box to select Excel 97-2003 Workbook.  

14. Click Save. 

15. Close Excel. 

Setting Up a Map Document from an Existing Map Document 

Now you will return to ArcMap to map the land cover data by state. 

1. Maximize ArcMap. 

Because you already have the map document from the prior exercise set up with the correct 

default database and it has been set to save relative path, you will use this map document as a 

template, rather than starting a new one. 

2. Click the Insert menu and select Data Frame. 

This creates a new data frame in which you will map your state land cover data, so you no longer 

need your old data frame containing the downtown Houston parcels. 

3. In the Table of Contents, right-click the top Layers data frame and select Remove. 

You will now save this map document under a different name so as not to overwrite your map 

document from the first exercise. 

4. Click the File menu and select Save As…. 

5. In the ‘Save As’ window, change the File name to “USLandCover” and click Save. 
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You will now explore the state data. 

6. On the right side of the ArcMap window, click the Catalog tab. 

7. In the TabularData geodatabase, drag the US_States feature class into the Map 
Display. 

8. In the Table of Contents, right-click the US_States layer and select Open Attribute 
Table. 

Examine the attribute table for the US_States layer and notice that the field containing the state 

names is “NAME10”. 

9. Close the attribute table. 

10. On the right side of the ArcMap window, click the Catalog tab. 

It is likely that your newly saved US_LandCover Excel file will not be visible in ArcCatalog yet. 

You will need to refresh the Data folder for it to appear. 

11. Right-click the TabularTutorialData folder and select Refresh. 

12. Double-click the USLandCover Excel file to expand it and see the individual 
worksheets. 

Because a single Excel file can have multiple worksheets and each worksheet is treated in 

ArcGIS as a separate table, you must always specify which specific worksheet you want to use.  

You cannot add in an entire Excel file directly into ArcMap. 

13. In the USLandCover Excel file, drag the Sheet1$ worksheet into the Map Display. 

14. In the Table of Contents, right-click the Sheet1$ worksheet and select Open. 

Examine the Sheet1$ table and notice that the field containing the state names is “State”. 

Using your knowledge from the first exercise, try to join the Sheet1$ worksheet to the US_States 

feature class and symbolize the states by both the percent developed land and the percent forest 

land.  If you get stuck, ask for help. 

 

 

Last updated September 17, 2012. 


